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1 Introduction

The SmartRF™ Packet Sniffer is a PC software application used to display and store RF packets
captured with a listening RF HW node. Various RF protocols are supported. The Packet Sniffer filters
and decodes packets and displays them in a convenient way, with options for filtering and storage to a
binary file format.

The Packet Sniffer is installed separately from SmartRF® Studio, and must be downloaded from the
Texas Instruments web site.

A shortcut for all supported signalling protocols will be placed on the Windows "Start menu" after the
installation.
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1.1 Protocols

The supported protocols can be seen in the Launch window when starting the packet sniffer. The
following combinations of protocols and HW (RF Device) are supported:

Can be used to

Protocol Version Capture device capture packets from
Bluetooth® | Bluetooth CC2540 USB Dongle (B:Ii §?0400th® low
low energy | core spec 4.0 CC2540EM+SmartRFOSEB energy devices
CC2531 USB Dongle gggjﬁ%g
2007/PRO CC2530EM+SmartRFO4EB/SmartRFO5EB CcC2431
2006 CC2520EM+SmartRFO5EB CC2480
ZigBee 2003 CC2430EM+SmartRF04EB/SmartRFO5EB CC2520
CC2431EM+SmartRFO4EB/SmartRFO5EB CC2530
CC2430DB CC2531
2003 CC2420EM+CC2400EB CC2420
CC2531 USB Dongle
CC2530EM+SmartRFO4EB/SmartRFO5EB CC2533
. CC2520EM+SmartRFO5EB
RFACE | ZigBee RFACE 1.0.1 | o os 4 30EM+SmartRFO4EB/SmartRFOSER gggggg
CC2431EM+SmartRFO4EB/SmartRFO5EB
CC2430DB
CC2531 USB Dongle CC2430
CC2530EM+SmartRFO4EB/SmartRFO5EB CC2431
CC2520EM+SmartRFO5EB CC2520
CC2430EM+SmartRFO4EB/SmartRFO5EB CC2530
CC2431EM+SmartRFO4EB/SmartRFO5EB CC2531
CC2430DB
CC1100
111 CC1110EM“+SmartRFO4EB/SmartRFOSER ggﬁggE
B 110 CC1111 USB Dongle
i-g-g CC110LEM+TIXEB ggﬂig
- CC113LEM+TrxEB CC1111
CC430
CC2510EM+SmartRFO4EB/SmartRFO5EB CC§520
CC2511 USB Dongle CC2510
CC2511
CC1120EM+TrxEB CC1120
CC1121EM+TrxEB CCi1121
CC2420
CC2531 USB Dongle CC2430
CC2530EM+SmartRFO4EB/SmartRFOSEB | CC2431
CC2520EM+SmartRFO5EB CC2480
CC2430EM+SmartRFO4EB/SmartRFO5SEB | CC2520
CC2431EM+SmartRFO4EB/SmartRFO5EB | CC2530
CC2430DB CC2531
CC2533
. CC1100
Generic Any CC1100E
CC1101
CC1110EM+SmartRF04EB/SmartRFO5EB ggﬂg::
CC1111 USB Dongle
CC1150
CC1110
CC1111
CC430
CC2510EM+SmartRF04EB/SmartRFO5EB | CC2500

! When sniffing in the sub-1 GHz frequency bands, you need hardware that supports the operating frequencies. Also note that
CC1110 and CC1111 have limited support for some frequencies supported by CC1100E.
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CC2511 USB Dongle CC2550
CC2510
CC2511
CC1120EM+TrxEB CC1120
CC1121EM+TrxEB CC1l121

Table 1: Supported protocols

1.2 Hardware Platform

The packet sniffer can be used with different HW platforms. The following HW can be used:

CC2400EB + CC2420EM
CC2430DB

CC2531 USB Dongle.
CC Debugger + SmartRFCCxx10TB
CC2540 USB Dongle.

The applicable board must be connected to the PC through USB.

Figure 1: CC2400EB + CC2420

Note:

SmartRFO4EB + (CC2430EM, CC2530EM, CC1110EM or CC2510EM)
SmartRFO5EB + (CC2430EM, CC1110EM, CC2510EM, CC2520EM or CC2530).
TrxEB + (CC1101EM, CC110LEM, CC113LEM, CC1120EM or CC1121EM)

The Packet Sniffer started when selecting “IEEE802.15.4/ZigBee (CC2420)” will be different from the
others. A different GUI application will be started. The most important difference is that the packets will
only be stored in a RAM buffer. That means the GUI application will not be able to handle more packets
when the buffer is full. See the user manual for “Packet Sniffer CC2420” for more details. The manual
can be found under the “documentation” option of the start menu: start->Texas Instruments->Packet

Sniffer->Documentation->Packet Sniffer CC2420 user manual
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Figure 3: SmartRFO4EB

Note:
Observe the jumpers on header P3. For revision A and B of CC2430 (register CHVER < 0x02), the

jumpers must be set in the horizontal direction (in parallel with the display) like in Figure 2. For newer
revisions of CC2430, the jumpers should be set in the vertical direction (this is the default position).
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Figure 5: CC2511/CC1111 USB Dongle

Both the CC2511 and the CC1111 USB Dongle can be used as capturing device with the packet sniffer.
The Dongles must be pre-programmed with special firmware in order to work with the packet sniffer.
After installation of the packet sniffer, the hex file to be programmed can be found on the following
directory: <installation directory>\General\Firmware\ sniffer_fw_ccxx11.hex

The firmware can be programmed with the SmartRF Flash Programmer. To program the firmware on
the dongle, it must be connected to SmartRFO5EB or the CC Debugger via the debug connector. See
user manual for the flash programmer for details on how to use the flash programmer.
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Figure 6: CC2531 USB Dongle

The CC2531 USB Dongle must be pre-programmed with special firmware in order to work with the
packet sniffer. After installation of the packet sniffer, the hex file to be programmed can be found on the
following directory: <installation directory>\General\Firmware\sniffer_fw_cc2531.hex

The firmware can be programmed with the SmartRF Flash Programmer. To program the firmware on
the CC2531 Dongle, it must be connected to SmartRFO5EB or the CC Debugger via the debug
connector. See user manual for the flash programmer for details on how to use the flash programmer.

Figure 7: CC Debugger + SmartRFCCxx10TB

Figure 8: CC2540 USB Dongle

The CC2540 USB Dongle must be pre-programmed with special firmware in order to work with the
packet sniffer. After installation of the packet sniffer, the hex file to be programmed can be found on the
following directory: <installation directory>\General\Firmware\sniffer_fw_cc2540.hex

The firmware can be programmed with the SmartRF Flash Programmer. To program the firmware on
the CC2540 Dongle, it must be connected to SmartRFO5EB or the CC Debugger via the debug
connector. See user manual for the flash programmer for details on how to use the flash programmer.
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Figure 9, TrxEB

The USB MCU on the TrxEB board must be programmed with FW revision “0014” or newer. The
revision can be seen in the SmartRF Flash Programmer or SmartRF Studio when the board is
connected to the PC with a USB cable.
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1.3 Data flow

On the PC side the packets will be stored in a disk buffer. The total amount of packets that can be
stored depends on the packet size and the size of the hard disk. During operation the packets will be
cached in a RAM buffer to improve the access time when a packet is to be displayed in the GUI.

Figure 10: Dataflow for the packet sniffer (SoC) below shows the data flow for the packet sniffer.

Connected Device PC
A

SoC/Transceiver* Abstraction layer
Data Buffer** 8 kB buffer

4

Temporary

USB controller
Disk file

Data Buffer

Cache buffer
In RAM

A

Screen/GUI

Figure 10: Dataflow for the packet sniffer (SoC)

* For the moment it is only the CC2520 transceiver that is supported by the packet sniffer.
** The buffer is only applicable for the System on Chip devices (SoC).

If the PC application is not able to read the packets from the connected devices data buffer fast enough,
an “Overflow” error will be given by the device and the packet sniffer will show the error on screen.

1.4 Software

The firmware on the SoC'’s required to run the sniffer will be checked and loaded automatically, if
needed, when the sniffer is started. This can be seen on the status bar in the lower left corner.

The same apply for the USB controller, but the user will be asked to do the update and the user has the
possibility to reject the update. In that case it might be that the sniffer is not working properly.

The following operating systems are supported:

Windows XP/Pro (32 bit)
Windows Vista (32 bit)
Windows Vista (64 bit)
Windows 7 (32 bit)
Windows7 (64 bit)
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2 User Interface

2.1 Launch Window

To select between the different options for protocol and HW configuration, a launch window will be
shown when starting the sniffer.

l'l‘ Texas Instuments Packet Sniffer.

RB Texas Packet Sniffer
INSTRUMENTS

Wer, 2.10.1

Select Prokocol and chip bype:

[IEEE 502,15, 4/Figbee (T

"Required Hi platform: SmartRFO4EE + CC2430EM or CC24300B."

Click Start button to launch Packet Sniffer:

[ Start | ( Exit |

Figure 11: Screen shot of the packet sniffer launch window

To start the packet sniffer a combination of protocol and chip type should be selected. Then the start
button should be clicked. If a packet sniffer session has been started and the launch window is closed,
the sniffer session will still remain active and must be closed explicit if required.

2.2 Packet Sniffer window of an active session

The main window of the packet sniffer can be divided into two sections:

e Atthe top: A packet list, which displays the various fields of the decoded packets.
e At the bottom: The following seven tabs:

o Capturing device: Selects which capturing device to use.

o Radio Configuration: Input data to configure the radio of the capturing device. E.qg.
Channel number for IEEE 802.15.4 devices.

o Select fields: Select which fields to display in the packet list.

o Packet details: Displays additional packet details (e.g. raw data).

o Address book: Contains all known nodes from the current session. Addresses can be
registered automatically or manually, and they can be changed or deleted.

o Display filter: Packet filtering with user defined filter conditions. A list of all fields which
can be used to define the filter condition is given. From this list a filter condition can be
defined by combining these fields with AND and OR operators.

o Time line: Displays a large sequence of packets, about 20 times as many as in the
packet list, and sorted by either source or destination addresses.

The packet sniffer screenshot in Figure 12 shows an example from the IEEE802.15.4/ZigBee protocol.
The status bar displays the total (unfiltered) number of captured packets, the number of packets with

errors (checksum error and the number of occurrences of buffer overflow) and the status of the filter
function. If filter is on, it will show the number of packets which have passed current filter conditions.
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Texas Instruments SmartRE Packet Sniffer, IEEE 802.15.4 MAC and ZigBee 2006
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Figure 12: Packet sniffer screenshot from the IEEE8022.15.4/ZigBee protocols
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2.3 Menus and Toolbars

SWRU187F

Menu Button Key Description
File>Reset... [ Empties the packet buffer and the packet list.
File>Open data... =y Load packet buffer from file
File->Save data... lad Save packet buffer to file
W * Display the tabs at the bottom of the window.
» F5 Start the packet sniffer (does not empty the
buffer)
n F6 Pause the packet sniffer
’@ * Delete all captured packets when starting
- Switch automatic scrolling on/off
%Bm Switch between normal font or small font in the

packet view window.

Settings >
Cash buffer size...

* The size of the packet RAM buffer in
megabytes.

Settings >
Clock multiplier...

* A clock multiplier, which allows you to
compensate for clock speed differences on the
connected device and the hardware running the
network application

Settings >
Packet broadcast ...

* Configuration of packet broadcast.
Enable/disable the feature, select broadcast
address and UDP port number, select broadcast
only

Help >
About the PSD file format

Help on the file format used to save data.

Help>User Manual

Opens this document in your PDF file viewer

Help>Rev. History

Revision history (bug fixes, new features, etc.)

The application is closed by double-clicking in the top left corner, or single-clicking on the X-symbol in

the top right corner.

Iltems marked with a star (*) are saved to Windows registry between each session.

For the ZigBee and SimpliciTl protocol there are options to select the protocol version. This can be

seen in the toolbar as a drop down list:
between each session.

Cash buffer size:

ZigBee 2006

j. The selected version will be saved

The cash buffer is a RAM buffer that is allocated to contain packets that is displayed by the packet
sniffer. It is used to optimize the access time when the GUI asks for information to display a packet.

The cash buffer function tries to anticipate which packets that will be requested next and will try to load

the buffer with these packets in the background.

Clock multiplier:

A clock multiplier, which allows you to compensate for clock speed differences on the connected device
and the hardware running the network application (Synchronizing the clock on the sniffer device with

the clock on the network devices).

Example:

Ensure that the time stamps are given in microseconds to get accurate numbers (default). Measure a
known time interval (e.g. the distance between a few beacons for the IEEE 802.15.4 protocol). Divide
the desired value by the real value, and enter this floating-point factor into this field. Clock multiplier:
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2.4 Packet broadcast.

From version 2.14 of the General Packet Sniffer it is possible to stream packet data to other
applications via a UDP-port. This feature can be configured from the Settings -> Packet broadcast
menu. The feature can be disabled altogether, and it is possible to select broadcast IP-address and
UDP port. The IP-address is restricted to the ‘local’ interface to avoid inadvertently flooding the network
with packets. Optionally the operator may choose to broadcast data only. This is useful when capturing
data over time for storage as it avoid the problem of the buffers of the Packet Sniffer GUI application
filling up.

Packet broadcast g|
Broadcast
Address Port
127 . 0 .0 . 255 4000
I Broadcast enable I ﬁ:}E{g&EEE{EHiﬁ

Figure 13: Packet broadcast setup

A PERL-script is provided as an example of how to use the broadcast data. It is located in <installation
directory>\scripts\udp_receive.pl. It received data on port 4000 and displays the packets in
hexadecimal format. Please note that the packet format is the same as the PSD-format described in
chapter 5 Format of packets saved to file . To save a PSD-file, the application will have to pad the
payload so it makes up the total number of bytes given in the <protocol>.plt file (Located in the plugin
folder). The file contain “Packet_length_raw_data=n" where n is the buffer size excluding the packet
info byte. E.g.: “Packet_length_raw_data=150" means that the total number of bytes for each packet
should be 151.

Time {us) Payload R5SI
P.nbr. Length Lal fFes
nor 10 ength § ) 22 00 07 20 61 10 f (aBm) | 1@
1 -0 16 |60 19 04 cc co FF 01 | 31 Q236 ok

Figure 14: Sample packet in Packet Sniffer GUI

&2 C:\Perl\bin\perl.exe

UDPF Server Waiting for client on pult 4008 ...
1 €127.A.8.255:1993> sent : 3

A byt
A3 01 B0 9@ B8 B4 2A FE B3 00 6@ BB EB 18 61 88 88 07 20 61 17 68 19 B4 CC CA FF 81 BE EB _

Figure 15: Sample packet as shown by udp_receive.pl
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2.5 Capturing device
The Capturing device tab is used to select the required device.

Depending on the selected protocol, the applicable devices will be shown in the list. The list will
automatically be updated when an applicable device is connected to a USB connector.

The Capturing device must be selected before the packet sniffer can be started (which is done by
clicking the tool bar button, or hitting the F5 key).

Capturing device | Fadio Ennfiguratiun] Select fields] Packet details] Address I:u:u:uk] Dizplay filter] Time Iine]

Select captuning device:

EB ID 5451, Chip tvpe: CC2540, EB twpe: CC2540 LISE Dongle

Figure 16: Capturing device

Sniffer communication interface:

If the EB type is CC Debugger and the chip type is CC1110 or CC2510, an additional option will be
visible in the Capturing device panel. The sniffer communication interface must be selected.

The default value is USARTO and is applicable when CC Debugger is used together with the
SmartRFCCxx10TB board. See figure below.

Capturing device | Fadio Ennfiguratiun] Select fields] Packet details] Address I:u:u:uk] Dizplay filter] Time Iine]

Select captuning device:

EB ID 1264, Chip type: CC1110, EB tope: CC Debugger

Sniffer communication interface
+ USARTO " USART

USART1 should be used for all other combinations with CC1110EM or CC2510EM.
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2.6 Radio Configuration

SWRU187F

The Radio Configuration tab is used to select the parameter values required to configure the radio of

the capturing device.

The parameters depend on the selected capturing device.

IEEE 802.15.4 devices:

For IEEE 802.15.4 devices, the required channel must be selected.

Capturing device Hadio Configuration l Select fields] Packet details] Address I:u:u:uk] Dizplay filker | Time line

[EEE 802.15.4 Channel: |EI:-:‘I1 (2435 MHz)

El

Proprietary devices:

These radios support a lot of programmable RF parameters.

Capturing device Hadia Canfiguration | Selact fields] Packet details] Address I:n:n:-k] Dizplay filter | Time line

Reaizter zettingz
Select Channel:

Select File Registers
IT 2433Mhz_250kE aud_bk A Mame [Val. A
434MHz_250kEaud_GI FSCTRLY 0xl:
868t hz_250kE aud_GF FSCTRLO 0wl
Freq-2433MHz_F ate-2* FREQZ Om
zhiffer_cc1110 FREQ1 OxE"
smpl_sniffer_cc1111 FREQO 0x3
smpl_shiffer_cc2510 MOMCFGA 021 o
arnml_switfar ~e 7R it amee g
Erowse... "Write ta file

Reqgister Lpdate

Regizter: W alue:

Apply

The radio settings should be given in a text file. The file can be created by SmartRF® Studio. This
makes it easy to get all the correct register settings calculated by SmartRF® Studio. See chapter 6 for

further details.

After installation of the SmartRF™ packet sniffer, a default file will be available in the subdirectory of the

applicable plugin.

The format of the file is shown in the example below:
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#Name |Addr. |Val. |Description

Fommm fo———— R D D bt LT LT

PKTLEN |0xDFO02 | 0xFD|Packet length.

PKTCTRL1 |0xDF03|0x04|Packet automation control.
PKTCTRLO |0xDFO04|0x05|Packet automation control.
FSCTRL1 |O0xDF07|0x07|Frequency synthesizer control.

FREQ2 |0xDF09|0x1C|Frequency control word, high byte.
FREQL | 0xDFOA|0x80 | Frequency control word, middle byte.
FREQO |0xDFOB|0x00| Frequency control word, low byte.

MDMCFG4 |0xDFOC|0x2D|Modem configuration.
MDMCFG3 |0xDFOD|0x3B|Modem configuration.
MDMCFG2 | 0xDFOE | 0x73 |Modem configuration.
MDMCFG1 |0xDFOF | 0x22 |Modem configuration.
MDMCFGO |0xDF10|0xF8|Modem configuration.
DEVIATN |0xDF11|0x00|Modem deviation setting (when FSK modulation is enabled).

MCSM1 |0xDF13|0x0C|Main Radio Control State Machine configuration.
MCSMO |0xDF14|0x10|Main Radio Control State Machine configuration.
FOCCFG |0xDF15|0x1D|Frequency Offset Compensation Configuration.
BSCFG |0xDF16|0x1C|Bit synchronization Configuration.

AGCCTRLZ2 |0xDF17|0xC7|AGC control.
AGCCTRL1 |0xDF18|0x00|AGC control.
AGCCTRLO |0xDF19|0xB2|AGC control.

FREND1 |0xDF1A|0x56 | Front end RX configuration.
FRENDO |0xDF1B|0x10|Front end RX configuration.
FSCAL3 |0xDF1C|O0xA9|Frequency synthesizer calibration.
FSCAL2 |0xDF1D| 0x0A|Frequency synthesizer calibration.
FSCAL1L |0xDF1E|0x00 | Frequency synthesizer calibration.
FSCALO |0xDF1F|0x11|Frequency synthesizer calibration.

PA TABLEO|OxDF2E|OxFF|PA Output Power Setting.

When the file is selected, the register values will be shown in the “Registers” frame.

To modify the register value, double click the register name. The register name will appear in the
“Register update” frame. The value can be changed in the “Value” field. Click on “Apply” to use the new
value. The changes can be seen in the “Register” frame. The new values can be written to file with a
click on the “Write to file” button.

Bluetooth Low Energy devices:

For Bluetooth Low Energy devices, the Advertising channel must be selected.

Capturing device Radio Configuration lSeIecl fields] Packet details] Address bnnk] Dizplay filterl Time Iine]

Advertising Channel: 38 [242E6 MHz] -
[¥ Conrect to Initiator Address 112233445566 [hex]

The capture device can be configured to follow a data connection between a specific Bluetooth low
energy master (initiator) and slave device. In the "Radio Configuration tab", click the checkbox next to
the "Connect to Initiator Address" and write the address of the initiator (master) device. If this option is
not selected, the capture device will start following the first data connection that appears on the current
advertising channel
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2.7 Selectfields

The field selection tab can be used to select which fields to display and which to hide in the packet list.
This feature is particularly useful for low-resolution screens (less than 1024x768). The fields are
grouped in several colour coded categories.

The time stamp can be displayed in microseconds or milliseconds. The payload data can be displayed
as hex-bytes or as plain-text. In plain-text format all non-printable characters will be replaced by a "*".

The Selected Fields list box gives the possibility to select predefined field groups. It is also possible to
select “all” or “none”.

Each frame can be shown either with its LQI (Link Quality Indication, ranging from 0x00 to OxFF) or
RSSI (Received Signal Strength Indicator with an approximation to the actual RF level, in dBm). The
LQI parameter is derived from the IEEE802.15.4/ZigBee protocol specification. The exact definition will
depend on the used protocol.

The example below shows the fields defined for the SimpliciTI protocol.

Capturing device] Fiadio Corfiguration  Select fields l Packet details] Address I:u:u:uk] Dizplay filter] Time Iine]

[ Packet Header O simplicty Header [ 2o Pavioad O Metweark Aop ClFoater

Application payload

|

nel v

Time stamp: |Milizeconds Payload format; | Butes vl Selected Fields: |All - | LOI/RSSI

Figure 17: Select Fields panel

Tips:
Extended selection is used to operate the controls:
e To select a range of fields:
o Click and drag over the fields that should be selected, or....
o ... select the first field, hold down the "Shift" key, and select the last field.
e To select/unselect a single field:
o Hold down the "Ctrl" key and click on the field to be toggled.
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2.8 Packet details

By double-clicking on a packet in the packet list, additional details, as shown below, will be displayed.
This example show details from the SimpliciT| protocol.

Capturing device] Radio Cu:unfiguratiu:un] Select fields  Packet detailz | Address book | Dizplay fiter | Time line

Packet index: 1

Length: 11

Flaw data [hex): 41 88 00 10 20 BE BB AA A4 FF FF
RS5| [dBm]: -394

Comrelation value: 105

CRCOE: 1

Figure 18: Packet details panel
The packet index shows the index for each captured packet, starting with index 1 for the first packet.
The RSSI value is read from the connected device and adjusted with a given offset value to get an

approximate value in dBm. The correlation value is equal to the value read from the connected device.
See the datasheet of the connected device for detailed information on the RSSI and correlation values.
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2.9 Address book

The address book contains all known Node addresses from the most recent session. By selecting
"Auto-register” (on by default), the packet sniffer will register all addresses automatically and add
entries into the address book. The example below show the fields defined for the IEEE 802.15.4/ZigBee
protocols.

Capturing device] R adio C-:-nfiguration] Select fields] Packet detail;  Addriess book lDispIa_l,J filter | Time line

| | =l x| e
Remowe | al
MNode name [ P& id | Short address | IEEE extended address | :
Auto-registered 0 (=004C 0001 (=0000000001020316 v Autoregister
Auto-regigtered 1 Ow00aC Q0000 «FFFFFFFFFFFFFFFF
Alto-reqistered 2 (x00ALC 0=FFFF 0007 24B00000B 00AC M P
Auto-registered 3 Ox00AC 01 43E 0001 24B00000BE0F 1 e

tove DOWN

Figure 19: Address book panel

Nodes are added/replaced manually by clicking the "Add" button, or by pressing the "Enter" key while
standing in one of the top fields.

Nodes can be removed by clicking the "Remove" button, or by pressing the "Delete" key while a node is
selected in the address list.

Nodes can be moved up/down by using the rightmost buttons, or the "Alt + U" and "Alt + D" key
combinations.

Depending on the protocol it may be required with manual editing of the fields in the address book to
correct for address conflicts.

Below are examples where manual editing for the IEEE 802.15.4 protocol are given.
e There has been a PAN ID conflict.
e Adevice has left the network, and another device has been given an already used short
address (the extended address will be replaced).
e Association response commands have not been detected.

Tips:
Fast editing of node names can be done using the following procedure:

Select the first auto-registered item in the address list

Hit "Enter" to copy the data and move to the node name field

Enter the new name

Hit "Enter" to replace the old entry and move back to the address list
Move one line down by using the down arrow.

Go to step 2

ouhkhwNE
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2.10 Display filter

The Display filter tab allows for filtering on all fields defined in the Field Name window.

A template is provided to ease the definition of the filter condition. The template will show the short
name for each field. If the field has sub fields, the definition of all sub fields will be shown within
brackets. Some fields will be dependent of other fields. This will also be shown in the template.

When the required field is selected, the template can be moved to the single line Filter condition window

by pushing the 2 | hutton or the |ﬂ| button. The “First” button will remove all existing conditions

and set current template as the first condition. The “And” button will add current template to the existing
conditions and the conditions will be evaluated with the AND operator. When the template has been
moved to the single line Filter condition window, it must be modified to give the real values of the
requested fields. The value is indicated with an “x” in the template. If the filter condition of a field with
sub fields only requires evaluating the first sub field value, the sub field value can be given without
brackets.

Example:

Figure 20 below shows an example from the IEEE 802.15.4/ZigBee protocols. The template
of the Frame control field is:

FCF=(Type=x, Sec=x, Pnd=x, Ack_req=x, Intra_PAN=Xx)

If it is only required to test on the “Type” sub field, the condition can be simplified the following
way:

FCF=BCN

Note: This is only possible for the first field in the definition of sub fields.

It is not required to fill in the values of all fields. If the filter condition only requires checking some of the
sub fields, only those fields should be given.

Example:

Same as previous example, but this time it includes checking the “Type” and “Ack_req”
values. This condition should be given as follows:

FCF=(Type=BCN, Ack_reqg=1)

When all conditions that should be evaluated with the AND operator are defined, the condition can be

moved to the multi line Filter condition window with the L 2l button (“Enter” will give the same
result). In this window several filter conditions can be added and all the conditions in “vertical” direction
will be evaluated with the OR operator. To summarize: Conditions in the horizontal direction are
evaluated with the AND operator. Conditions in vertical direction are evaluated with the OR operator.

To remove a line from the multi line filter condition, select the required line and click the MI

Al

button. To remove all the lines from the multi line filter condition, click the | button.

The button Appl fiter will activate the filter and the packet window will be redrawn with packets that

comply with the given filter condition. The Tum oft fiter button should be used to disable the filter
function. The packet window will be redrawn again and all packets will be visible. The filter function can
be enabled and disabled while the sniffer is running.
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Capturing device] R adio Cnnfiguration] Select fislds | Packet details] Address ook Display filter lTime Iine]

Field Hame: Template: Filter management;
|Flame control field j |FCF=[T5Jpe=>:, Sec=x, Pnd=x, Ack.reg=x, P First | And | Add
Filter condition

Remove
|FCF=BCN Add

Open
FCF=BCM Remove | Al
Save
Apply filker
terge

e

Figure 20: Display filter panel

Filter management:

On the right side of the panel, a Filter management function is provided. The filter management
contains a database of defined filters. The database can be saved to a file and read from a file. The file
is formatted as a plain text file and can be manually updated if required.

Below is an example of a filter database file. The filter name is given within square brackets [ ] and the
filter conditions are given on the following lines. In this example the filter condition is: Dest. Address =
0x2430 OR 0x1749

[address]
DAD=0x2430
DAD=0x1749

To add a filter definition to the database, the e button should be used. In order to add the
filter to the database, a filter name must be given in the window to the left of the button. When the name
is given and the “Add” button is pushed, the current filter definition (the multi line window of the filter
condition) will be added to the filter database. The name of the filter will appear in the list of filters
(Window below the filter name).

To remove a filter, select the required filter in the list of filters and push the ﬂl button.

The filter database can be read from a file with the ﬂl button. To save the filter database to

afile, use the ﬂl button.

To add filter definitions from a file, without deleting the existing filters in the database, the ﬂl
button should be used. This will open the given file and add the filters to the existing filter database. If
the given filter name already exist in the filter database, the name will be modified with an additional
digit at the end of the name.

To use a filter from the filter database, double click on the filter name and the filter condition will appear
in the multi line filter condition window at the left side.

Note:
When packets are filtered out, the delta times shown in the Time fields still show the delta time to the
previous packet captured, not the previous packet shown.

2.11 Time line

The time line displays all received packets, ordered horizontally by the time of reception and vertically
by source or destination address. Selecting a packet from the time line will instantly be reflected in the
packet list, and vice versa, thus allowing for efficient navigation in large collections of packets.
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Capturing device] Radio Configuration | Select fields | Packet details] Address book | Display filker  Time ling
270 -

SOURCE <-148
Urreqistered/broadcast mmE R I n nnn
Autoregiztered 0 1 [} ]
Auto-registerad 1

Autoregiztered 2

Auto-registered 3

Figure 21: Time line panel

Double-click in the left section of the time line to switch between destination and source.
Packets are selected by clicking and/or holding down the left mouse button.
The time line can be scrolled clicking and holding down the right mouse button (drag).
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3 Encrypted Payload

Decryption of encrypted data is only supported by the Bluetooth low energy packet parser.

3.1 How to use the decryption feature

1. Copy the file “ltk.txt” with the Long-term key (LTK) to the root directory “c:\".
The file can be found in the “BLE” plugin directory.
Typically: C:\Program Files\Texas Instruments\Packet Sniffer\General\Plugin\ble

2. Modify "ltk.txt" with the right Itk. The format is MSO-LSO.
E.g. If the 1tk=0x001122334455667788399AABBCCDDEEFF
The file will have to be "00112233445566778899AABBCCDDEEFF" as its very first line

3. Run the sniffer like normal. Encrypted packets will be decrypted and flagged as "Encryption
Enabled". Payload and MIC will be displayed on the GUI.

3.2 Limitations
Decryption is supported with the following limitations:
1. The decryption will fail if one or more packets are sent but failed to be captured by the capturing
device. The decryption algorithm depends on the timing, packet counters (one for each side)

and the direction of the packet. There are algorithms in the parser to determine these
parameters but they can’t capture all the scenarios where one or more packets missing.

24/32



13 TEXAS SWRU187F
INSTRUMENTS

4 Know Issues

4.1 Bluetooth Low Energy

The capture device currently ignores the connection timeout parameter for an active connection. This
means that the sniffer will not know that a connection between two BLE devices is "down" if no new
packets are received for the duration of the connection timeout. The reason this is not supported by the
sniffer, is to remedy the case where the sniffer follows a data connection between two remote devices
and thus is likely to lose a number of packets for a period of time that exceeds the connection timeout.

When the actual connection is terminated due to a connection timeout, the sniffer must be stopped
(click the pause/stop icon) and restarted (click the play icon) in order to follow a new connection.
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5 Format of packets saved to file

The figure below describe the packet format for packets saved to a Packet Sniffer Data(PSD) file. The
number of bytes is given for each field.

B ¢ 8 [« [ [2] s ]

FCS

Payload

Length

Timestamp

Packet number

Packet Information

Figure 22: Packet format in PSD file

Packet Information:

New field introduced from version 2.3.0. Contains information used by the packet sniffer to read the
data correctly.

Bit 0: Length includes FCS.

Bit 1. Correlation used.

Bit 2: Incomplete packet.

Bit 3-7: Not used.

Timestamp:

64 bit counter value. To calculate the time in microseconds this value must be divided by a number
depending on the clock speed used to drive the counter tics on the target. (E.g. CC2430EM -> 32,
CCxx10 -> 26, SmartRFO5EB + CC2520EM -> 24). The timestamp on the first packet will be used as
offset value for all packets. That means that packet number 1 will be shown in the packet sniffer with
time = 0.

Length:
The length will or will not include the FCS field depending on Bit O in the Packet information.

Payload:
Packet Information Bit 0 = 0 > n = Length
Packet Information Bit 0 =1 - n = Length — 2

FCS:

The checksum of the frame has been replaced by the radio chip in the following way:

BYTE 1: RSSI and if Correlation used, this byte is also used to calculate the LQI value.
BYTE 2: Bit 7: Indicate CRC OK or not.

Bit 6-0: If Correlation used: Correlation value.
If Correlation not used: LQI.

See data sheet for the applicable chip for further details.
Spare:
The number of spare bytes depends on the total amount of bytes used by the packet sniffer to save the

packet. The number of bytes depends on the protocol and can bee seen from the description of the
packet format under the help menu.
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6 Exporting register settings from SmartRF™ Studio

SmartRF™ Studio and its user manual can be downloaded from the Texas Instruments web site. See
the SmartRF™ Studio user manual for more details.

When the correct device has been selected, a list of preferred register settings will be shown in the
“Normal view” tab. After selecting the preferred register settings and optionally changing any of the
register values, choose “File/Export CCxxxx code...” from the menu to start the code export. This will
open the following window:

¥ Code export

Export Format

Select Registers Comtment Delimiters l:l
FSCTELL

Header I0CFGO
FECTELO
FREQZ
FREQL

Preview:

0x000E | 0x0& | Fregquency Synthesizer Comtre™
O0x000Z | 0x0& |GDO0 Dutput Pin Configuratic
0x000C|0x00|Fregquency Synthesizer Contrc
O0x000D | 0xZl |Frecuency Control Word, High
0x000E|0x62 | Frequency Control Word, Midc
FREQO 0x000F | 0x76 | Frequency Control Word, Low
MDMCFG4 0x0010|0xFE |[Hoden Configuration

|

|

|

|

|

|

|
H MOMCFGE | 0x0011|0x83 |Moden Configuration

RN RD | |Rd || rd AH | | ah || AD

u u u u u u u u u MDMCFGE | 0x0012|0x13 |Moden Configuration

|

|

|

|

|

|

|

|

l i 1’ _ 1’ TaE 1’ i 1’ MDMCFGL 0x0013|0xEZ |[Modem Configuration

! MDMCFCO 0x0014|0xF2 |Moden Configuration
Ox000&] 0x00 | Chatnel Huwber
0x0015|0x1lE |[Modenm Deviation Setting
0x0021|0x56 |Front End BX Configuration
0x00Z2Z|0x10|Front End TH Configuration
Footer MCEMO O0x0018|0x1%8 |Main Radio Control 3tate Mac
FOCCFZ 0x0012|0xle|Fregquency Dffset Compensatic
ESCFG | 0x001&|0x&C |Bit Synchronization Conficar
AGCCTELE | 0x001E|0x03 |AGC Control
AGCCTRLL| 0x001C|0x40|AGC Control
AGCCTELO| 0x0010 | 0x21 |AGC Control

. . FECALZ | 0x00E3 | 0xES |Frecquency Synthesizer Calibr™
Packet sniffer settings | 3 =

Al :E: ¥ R Export to File
RF zettings struct typedef —_—
R!—' sgﬂ.ings ) Copy to Cliphoard

CHANNE
Registers ‘@RN@@<<@ | B=<@E0:xEAHE | 0x@VHE | 3RAR DEVIATH

FREND1
FRENLO

Templates

C51 SFR definitions

Figure 23: SmartRF Studio Code Export

Select “Packet sniffer settings”. The register settings with correct formatting can be seen in the
“Preview” tab to the right. Select “Export to file” to save the settings to file.
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7 Help

The packet sniffer provides help through so-called tool-tips. By moving the cursor over a field (e.g. a
button or a text field) and holding it in the same position for about half a second, the text will appear in a
yellow box slightly below the cursor:

Capturing device] R adio Cnnfiguration] Select fields] Packet details] Addiess book  Display filter ] Time Iine]

Figld M arne: Template: Filter management:

|Frame cantral field j |FCF=[T_I,Jpe=:4, Sec=x, Pnd=x. Ack.reg=x. P First | And | Add

Filter condition

|FCF=BCN Add
FCF=BCH i Remove| &l

& nnly Flker
The complete Filker conzist of conditions in horizontal and vertical direction.
The conditionz in horizontal direction will be checked with an AND operator.
The conditiohs in the vertical direction will be checked with an OR operator.

Remowe

Open

Save

herge

Jddl;

Figure 24: Display filter panel with the tool-tip shown

Keyboard and mouse button events will cause the tool-tip to disappear, or not be displayed at all.
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8 Troubleshooting

This section contains some troubleshooting tips that should be used if the packet sniffer does not
function as expected. Execute the steps one by one until the problem is solved.
A) The evaluation board is not detected (it does not appear in the list box in the Setup tab)

Using smartRFO4EB + CC2430EM

Make sure that the USB cable is connected and that a CC2430EM is mounted.

Check that the jumper between I_OUT and I_IN is connected.

Check that the jumpers on P3 are mounted correctly (see the CC2430DK user manual).
Press the "Reset" button.

Using 2430DB

Make sure that the USB cable is connected and power switch is in USB position.
Check that the jumper on P3 pin 1-2 is mounted

Check that all tree jumpers on P5 are mounted

Press the "Reset" button.

B) When pressing the “start button”, the following message is given:
"Not able to Start Sniffer. Try upgrade of USB firmware".

e Check if latest Firmware version of the USB controller is used. This should be version 0037 or
later. This can be seen by using the SmartRF Flash Programmer from Texas Instruments. The
figure below show an example from the flash programmer. The column “EB firmware rev” will
show the version. The Flash Programmer can be download from the Texas Instruments web
site.

& Texas Instruments SmartRF® Flash Programmer E“§|E|

*{3 TEXAS

Spstem-on-Chip  EB application [USE] | EB application [serial]] EB bootloader] MSP43D]

]NSTRUM ENTS EB ID | Chip type |EB bpe EE firrnware D | EB firmwsare rey
goc2 CC2430DB 0400

Actions:
™ Erase and program
{* Erase, program and verify

Perform actions

Figure 25: SmartRF Flash Programmer

C) When pressing the "start button”, the sniffer stops immediately (the start button is not grayed
out)
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e Disconnect the USB cable from the SmartRFO4EB or CC2430DB board, and plug it back in.

e Press the "Reset" button on the board.

e Disconnect the power cable from all evaluation boards and install the latest version of the
packet sniffer.

e Reboot the computer.

D) The program does not respond
e Press the "Reset" button on the connected Evaluation Board (EB).
E) The packets are not decoded correctly
e Packets with an FCS failure will probably not be parsed correctly (FCS = ERR).
e Make sure that the packet really is correctly formatted (compare the fields with the raw data in
the packet details tab).
F) Weird packets appear in the packet sniffer when not transmitting anything
e CC2430 will try receiving packets down to the RF noise floor. Sometimes it will also decode
packets which are decoded from noise only. These will appear in the packet sniffer. To avoid

this, enable FCS filtering in the toolbar.

G) The packet sniffer stays “idle” and does not receive any packets after “start button” has been
pressed.

e Check that correct channel is used in the setup panel.

e Check the jumper settings, see section 1.2 in this document. If a SmartRFO4EB board with an
CC2430EM module is used, make sure that the jumpers are set correct depending on the chip
revision. Revision A and B (register CHVER < 0x02), horizontal. Later revisions, vertical.

H) Error message when trying to start the packet sniffer.
If an error message about missing msvcp80.dll appears, or the error message shown below

appears when attempting to start the application, you may be required to install an additional
package from Microsoft.

@ This application has failed ko start because the application configuration is incorrect. Reinstalling the application may Fix this problem,

The package contains some additional runtime components needed by applications developed with
Visual C++. To resolve this problem, download the file vcredist_x86.exe from the URL below and
install the package.

http://www.microsoft.com/Downloads/details.aspx?FamilylD=32bc1bee-a3f9-4¢13-9¢99-
220b62a191ee&displaylang=en
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9.1 Document History

Revision | Date Description/Changes

F 07/07/2011 -A$?f€anvgr:V\éfF¥r?éf(f)é?oS\;ving EM's: CC1101, CC110L, CC113L, CC1120 or CC1121

E 14/03/2011 | Description of Packet Broadcast added.

I e P AL e

C 25/08/2010 Document updated with information about capturing device used for the Bluetooth Low
Energy protocol. Screen shots have been updated.

B 03/11/2009 | SmartRFCCxx10TB added as possible capturing device.

A 19/02/2009 | Description for SmartRFO5EB added.

- 03/09/2008 | First revision.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (T1) reserve the right to make corrections, modifications, enhancements,
improvements, and other changes to its products and services at any time and to discontinue any product or service without
notice. Customers should obtain the latest relevant information before placing orders and should verify that such information is
current and complete. All products are sold subject to TI's terms and conditions of sale supplied at the time of order
acknowledgment.

Tl warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's
standard warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this
warranty. Except where mandated by government requirements, testing of all parameters of each product is not necessarily
performed.

TI assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using Tl components. To minimize the risks associated with customer products and applications, customers should
provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any Tl patent right, copyright, mask
work right, or other Tl intellectual property right relating to any combination, machine, or process in which Tl products or services
are used. Information published by TI regarding third-party products or services does not constitute a license from Tl to use such
products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under
the patents or other intellectual property of the third party, or a license from Tl under the patents or other intellectual property of
TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is
accompanied by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is
an unfair and deceptive business practice. Tl is not responsible or liable for such altered documentation. Information of third
parties may be subject to additional restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by Tl for that product or service
voids all express and any implied warranties for the associated Tl product or service and is an unfair and deceptive business
practice. Tl is not responsible or liable for any such statements.

Tl products are not authorized for use in safety-critical applications (such as life support) where a failure of the TI product would
reasonably be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement
specifically governing such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications
of their applications, and acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related
requirements concerning their products and any use of Tl products in such safety-critical applications, notwithstanding any
applications-related information or support that may be provided by TI. Further, Buyers must fully indemnify Tl and its
representatives against any damages arising out of the use of Tl products in such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products
are specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by Tl as military-grade meet
military specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-
grade is solely at the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in
connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products
are designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any non-
designated products in automotive applications, Tl will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications
Amplifiers amplifier.ti.com Audio www.ti.com/audio
Data Converters dataconverter.ti.com Automotive www.ti.com/automotive
DSP dsp.ti.com Broadband www.ti.com/broadband
Clocks and Timers www.ti.com/clocks Digital Control www.ti.com/digitalcontrol
Interface interface.ti.com Medical www.ti.com/medical
Logic logic.ti.com Military www.ti.com/military
Power Mgmt power.ti.com Optical Networking www.ti.com/opticalnetwork
Microcontrollers microcontroller.ti.com Security www.ti.com/security
RFID www.ti-rfid.com Telephony www.ti.com/telephony
RF/IF and ZigBee® Solutions www.ti.com/Iprf Video & Imaging www.ti.com/video
Wireless www.ti.com/wireless

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2010, Texas Instruments Incorporated
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